Follow these instructions very closaly and do not skip any part.

Note: You may need your Windows 95/98 Operating System CD-Rom to add system files.
Note: All “ clicks” arewith theLEFT mousebutton unlessnoted otherwise.

Windows98 Start with page 3 step 3
Windows95 Start with page 1 step 1

Thefollowing ingtructionswill allow youto dia into Midcoast Internet through your
Windows95 Did-Up Adapter.

Letsget sarted, shall we?

Midcoast | nternet Solutionsmay not behed responsiblefor any problemscaused by thisconfiguration.

(1) Insgtalling Dial-Up Networking Services

* Click the* Start” button fromyour task bar. Select “ Settings,” then* Control Panel”
* Now double-click the“ Add/Remove Programs’ Icon
* Click onthe* Windows Setup” tab (seeWindowA)

\Window A
Add/Remove Programs Properties EHE

Inztall U ninstall indews Setup I Startup Disk I

Window B

To add or rernove a component, click the check box. 4 shaded box

means that only part of the component will be installed. To see Toadd or remove a component, click the check box, A shaded
what's included in 5 component, click Details. box means that orly part of the component will be installed. To ses
LComponents: what's included in & component, click Detailz.

1 [&] Accessibiity Dptions 0.4 MB

) @Accessones 75,3 MB ™ F3 DialUp N g B

P & Communications O Eg] Direct Cable Connection 0.5 MB

[v] & Disk Tools 1.2 MB v '% HyperT erminal 0.6 ME
[ & Microsaft Fax ZEME o B B Microsaft NetMesting 0.0 MB

| & Phane Dial 02MBE +
Space required: 1.9ME ¥ @ e —I
Space available on dizk: 2539.4 ME Space required: 1.9HME
— Description Space available on disk: 2541.9 MB

Includes acceszories to help vou connect to other computers
and online services.

4 of § compaonents selected Details... |
Detals. . |
Have Disk.... |

Description
Enables pou to connect to other computers by uging a modern.

oK I Caneel I Aaply I OK I Cancel |

* Double-Click “Communications,” and be surethereisacheck next to “ Dia Up Networking” (Window B)
* Select “ Ok” onall the pop-up windowsuntil you are back at the control panel
» Takeadeep breath. Y ou have completed step (1)
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(2) Ingtalling and Configuring TCP/IP

» From the Control Panel, double-click the “ Network” icon
* Click onthe“ Add” button (see Window C)

Window C
Network K

Corfiguration I |dentification I Accesz Contral I

The following network, components are installed:

=
4 | 3

Chdd T Remove | Froperties |

* Double-click “Protocol” fromthelist of available protocols(see Window D)

Window D
Select Network Component Type 2] x]

Click the type of network, component you want to install:

Add...
Cancel |

Protocol i= & 'language’ a computer uses, Computers
must uze the same protocol to communicate.

* Now alist of manufacturerswill be displayed. Select “ Microsoft” (see WindowE)

* Double-Click “ TCP/IP” fromthelist of available protocols ( The TCP/IP Dia-Up Adapter protocol has
been added--see Window E.)

Besurethereisonly ONE TCP/IPinthethe* thefollowing Network componentsareinstalled “ window

If you find that you have morethan one TCF/IP, highlight the extraone/sand click the remove button.

Select Network Protocol >l \Window E

Click the Metwork Protocol that pou want toinstall, then click OK. If you have
3 an installation disk for this device. click Hawve Disk.

Manufacturers: Metwork Pratocols:

i~ IPx/SP5¢-compatible Pratocol
Microgoft 32-bit DLC
Microsoft DLC

4~ SunSoft

Have Disk. .. |

,TI Cancel |
* Select “ OK” again. Now you will be asked to restart your machine. Restart it.

Note e If awindow saying "You must specify a name for your computer in the computer name box"
occurs, thenyou must click onthe"OK" button. Click thetab labled I dentification (see Window C).

Whereit says Computer Name put your Midcoast I nternet Solutionsusername. Whereit says\Workgroup put
in theword* workgroup.”
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Windows98 sart here, Windows95 conintue
(3) Ingtalling & Configuring your Dial-Up Networking Shortcut

* Double-click the “ My Computer” l1con

» Double-click the* Did-Up Networking” Icon

* Double-click the “ Make New Connection” lcon

* Type in a name for your connection, such as midcoast.com (see Window F)

Window F

Make New Connection

Tvpe a name for the computer vou are dialing:

Imidcoast.con‘l

Select a modem:

ICourier W Ewerpthing j
Configure. .. |

< Back I Mext » I Cancel I

* Besurethe correct modemisdisplayed. Click “ Next” (seeWindowF)
* Typeinthe phone number you useto cal Midcoast Internet’smodems ( For thelist of numbersseetheMIS
Telephone Directory & Contact Information) and thenclick “ Next” (see Window G)

Window G

Make New Connection

Type the phone number for the computer you want to call:
Area code: elephone number:

| 1 A{E

Country code:
IUnited States of America (1] j

< Back I Mewmt > I Cancel I

* Verify your connection name, then click theFinish” button

* A new iconiscreated with the connection name you have selected
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* Right-Click on the new icon, and select “Properties’ (see Window H)
Window H
£a Dial-Up Networking =13

File Edit Miew Connections Help

Make Hew
Connection

Connect

Create Shortout

Delete

Fename
Opens the property shee juiil >

Properties

* De-Select the* Use country and areacode” check box (seeWindowl)

Window | Window J
midcoast.com HE midcoast.com 2] x|
General I Server Types | Scripting I General Server Typez | Seripting I
Ty
Kk R ER Type of Dial-Up Server:
- Phane number. | PP Windows 35, Windows NT 35, Intemet B

Airea code: T elephone number:
I j 2 Fﬁmgﬂ_t —Advanced options:
County code: ™ Log on to network
IUnited States of America (1) j I Enable software compression
™ Use country code and area code ™ Require encrypted password

— Connect uzsing:

— Allowed network, pratocolz

I Cavrier V. Everything j - ideEu
Configure. .. |

¥ TCPAP TCRAP Settings... |

0K I Cancel |

il I Cancel |

* Click the “Server type”’ button (see Window J)

* Under “ Typeof Did-Up server,” besureit beginswiththelettersPPP”

It may say Windows 95 or 98 after it, dueto the operating systemyou may be using.
(see Window J)

» Uncheck everything except for TCP/IP. (TCP/IP should be theonly onechecked.) Click ok.
(see Window J)

* You have now successfully configured your Did-Up connectionfor Midcoast I nternet Solutions.
* Left click (only once) onthemidcoast.com iconyou’ ve created. Click on“file,” then “create shortcut.”

The programwill tell you * Windows cannot create ashortcute here. Do you want it placed on the desktop
instead ?” Click yes.
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(4) Installing the Software

(You may not need to install these programs if you have Windows 98 and

plan to use Internet Explorer and Outlook Express)
Check your computer to seeif you aready have aweb browser, such asMicrosoft I nternet Explorer or Netscape
Navigator. Besureal programsare closed before proceeding.

Insert The Midcoast | nternet Solutions CD and follow the on screeninstructions
If theinstall program doesnot start automeaticly whenyou insert the CD
Go to the Start menu.
In the Start menu choose run.
In the run window type d:\setup.exe
*note* d:\ represents the CDROM drive.

Whenyou get to thelist of programsavailableto install: (see Window K)
1) Install Eudoraby clicking onthe appropriate arrow and following theinstructions.

2) Install Acrobat Reader by clicking onthe appropriate arrow and follow theinstructions
(Not needed, but it isuseful for reading special formsonthe Internet).

3) Ifyoudonot already haveaweb browser, install Microsoft Internet Explorer or Netscape Navigator
by clicking onthe appropriate arrow and follow the instructions (Do not restart the computer when

prompted.) *note* Internet Exporer is already installed in Windows 98.

4) Optional Install SimpleTerm & Graphical FTP by clicking onthe appropriate arrow and follow the
instructions. These programsarefor transferring filesand remotely logging into other computers.

When finished instaling the programs, click on Exit CD Setup
*Now restart your computer

Now personalizethe programsyou haveinstalled (seestep 5).
Window K Midcoast Internet Solutions Setup

Midcoast Internet Solutions

Midcoast Maine's First Intarmet Provider

4 Eudora Light (E-Mail)
m Adobe Acrobat Reader

E Microsoft Internet Explorer
I_» Netscape Communicator
Opera Web Browser

[ SimpleTerm(Telnet)
[E@ Graphical FTP (File Transfer)

Exit Setup
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(5) Personalizing the software

Eudora Light (PC Email Software)

Eudora Light is a very nice program for composing electronic mail, sending mail, and replying to mail.
Personalizing Eudora

There are a couple of things you must do to personalize Eudora before you begin writing letters.

Options 2] x] |

Categony:

o

Getting Started

1.) Start Eudora Light

2.) In Eudora Light choose Options from the Tools menu.

«| POP account:

3.) Inthe Options window choose Personal | nfo. |user@midc:nast.cum

4.) In Personal Info put your email addressin the field
labled POP account and return address. (Your
e-mail addressis your username@midcoast.com

Beal name:

I-J oe Lger

example : carrots@midcoast.com) Retun address:
*note* Be sure that you use lower case lettersin your IuSer@midmaSt'mﬂ
POP account and return address fields. v Dial _
Lhalup uzername:
5.) Inthe Real Name field put your real name. Checking Mail |
s=ap
6.) Choose Hosts in the Options window FEy
Sending kail
7.) In the field labled SM TP put midcoast.com
) P = =l | ] 4 I Cancel

8.) Click OK

Y ou are done configuring EudoraL.ight.

*note* you cannot send or recieve mail unless you Options EE

have made a connection to Midcoast Internet Solutions  Categoy:

ol

«| POP account:

UsingEudora Iuser@midcuast.mm
To get any new mail waiting on our server, connect to Getting Started
the internet, open Eudora, and select Check Mail from A= SMTF:

the File Menu. After putting in your password, it will
connect to the server and fetch any waiting mail.

J Doe
Perzanal Infa

Imidn:u:uast.u:u:um

Fh:
Messages aready retrieved from the sever will show up —
inthe in box. You can get to the in box by selecting |
in box from the M ailboxes menu.

v . Finger:

To send a new message, choose New message Checking Mail |
from the M essage menu. =
Eudorais a very powerful program with many Sen?;i Ml
features. To learn how to use some of these features,
you can download a manual, or go to Eudora's web site = = OF. I Lancel

http://www.eudora.conv



Personalizing Netscape Communicator

1.) Start Netscape Communicator

Categony:
. . [ Appearance I'I,III"',_:I Specify the home page location
2.) Go to Preferencesin the Edit M enu. &1 Nawigator :
-- Mail & Groups — Mavigator starts with
. " Composer ¢ Blank page
3.) Select Navigator & Offine & Home page

- Advanced
£ Last page visited

4.) Put http://mwmw.midcoast.comin the location
feild, In the arealabled Home page.

—Home page
Clicking the Home buttor will take pou to thiz page.

————h Location; | sl et erelyy

Ize Current Fage Browse. ..

5.) Click OK
Y ou are done.

— History

Histany iz a list of the pages you have previously visited.

FPages in higtory expire after; IS days Clear Histom |

QK I Cancel Help

Personalizing Internet Explorer
1) Start Internet Explorer options ____________EHH|

Generall Conkection  Mavigation |F'n:ngrams| Securit_l,ll Advancedl

2.) Choose Options from the View menu

— Customize

Y'ou can change which pages to uze for vour start page,
zearch page, and the Links toolbar.

3.) Choose the Navigation tab

4.) In the Address field put http:/Awwv.midcoast.com Bage:  [StartPage E
Mame: IStarl Fage
5) Click Ok + Address: Ihttp:.-".-"www.midcu:uast.cu:umf’
Y ou are done. Uze Current IJze Default
— Hiztany

]l The Hiztam folder containg links to pages pouve visited.

Mumber of days ta keep pages in histony: |2D 3:

Wiew History...l Clear Hiztam |

QK I Cancel | App |
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K eep this sheet handy

(6) Connecting to Midcoast Internet Solutions

* Doubleclick the new Dia-Up networking icon (midcoast.com) you have created

* Typeinyour username(all lower case) asusername@midcoast.com Hit the tab key and type your password.
* Click the*Connect” button

* It will thendial, and connect to Midcoast | nternet Solutions

Your connection should now be established.

Totry out your connection, load up any of your Internet applicationssuch asinternet Explorer or Eudora.
Good Luck!!!

If this does not work, double check your name, password, and the settings you've made inthe last few pages, restart
your computer and try again.

Troubleshooting:

Q: When | try to dial, the computer says, “ Modem isin use by another application” or something to that
effect.

A: If you haveacall center, fax, or voicemail software, thismay be hogging the modem and not alowing Dia-Up
Networkingto useit. Y ou should disable or turn off the call center, fax, or voicemail answering programand continue. If
you do not know how to turnthisoff, you may haveto contact the manufacturer.

Q: Thecomputer dials, but getsa message stating that “ You have been disconnected from the computer you
aredialing”

A: Makesurethat the name and password are entered in the main screen of your Dial-Up Networking program. There
should be no spaces, and al letters should belowercase. The username and password will bejust asyou put themonthe
regigrationform.

Q: Thecomputer dials, but getsa message stating that “ Dial-Up Networking wasunableto establish a set of
network protocols’ or something similar.

A: First, make sure the name and password are correct as above. Then restart the computer and try again. If this
does not help, make sure the appropriate boxes are checked/unchecked in section 3 of these instructions.

Q: The modem disconnects me from the internet rather frequently when it shouldn't.

A: There are many reasons for this, but disabling call waiting and changing the modem init string seemto help. To
disable call waiting, put a* 70, (star seven zero comma) in front of the phone number. For example: 555-1212 would
changeto * 70,555-1212. Also, if another personin the house picks up the phone whileyou're using it for internet, they
could cause you to lose the connection.

Also, changing the modem init string to make it less sensitive to line noise can help. To do this, double click
on* My Computer”, then* Control Panels’, then* Modems’. Click on your modem, and then properties. Theclick onthe
“ Connection” tab, and then the advanced button. Add “s10=100" (sten equals one hundred, without the quotes) inthe
“extrasetting” field.

Midcoast I nternet Solutions

Techincal Support: 594-8277 or help@midcoast.com
fax machine 596-7248
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